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Introduction

Fluoxetine is the active ingredient in the common selective serotonin reuptake inhibitor

(SSRI) antidepressant Prozac. Fluoxetine prevents the reuptake of serotonin, thereby, increasing

the total amount of serotonin within the synapse. Individuals with depression have lower levels

of serotonin, therefore, their moods can benefit from an increased concentration of serotonin

within the synapse. Prozac is often used as a first-line antidepressant because it is safe, tolerable,

and effective at treating depression (Chu and Wadhwa, 2021). A lack of serotonin has been

linked to depression and recent studies have shown that mitochondrial dysfunction can also be a

cause of depression (Bansal and Kuhad, 2016). Neurons within the brain require a large amount

of ATP to function properly (  Allen et al., 2018). When mitochondria in neurons are impaired and

cannot meet the energy demand, various regions of the brain such as the hippocampus, cortex,

and hypothalamus are damaged ( Allen et al., 2018). Research into these observations shows that

impairment in these portions of the brain increases the likelihood that someone will develop

depression ( Allen et al., 2018).

Studies have shown that the mechanism in which neurons respond to an influx of

fluoxetine with the cell can decrease mitochondrial ATP production (de Oliveira, 2016).

Research into the effect of fluoxetine on mitochondria has shown an increase in Ca+2 ions in the

mitochondria (Charles et al., 2016). Fluoxetine causes the endoplasmic reticulum within neurons

to release an abundance of calcium ions into the cytoplasm of neurons (Charles et al., 2016). To

reach Ca+2 ion homeostasis within the cytoplasm of the neuron before apoptosis occurs, the Ca+2

ions are stored within the mitochondria (Charles et al., 2016). In order for the mitochondria to

regain their calcium ion homeostasis and remove excess Ca+2 from its matrix space, two

transporters NCLX (sodium/calcium exchanger) and/or permeability transition pore are opened



(Charles et al., 2016). ----------------When the permeability transition pore opens, the inner

membrane of the mitochondria depolarizes and stops oxidative phosphorylation (Charles et al.,

2016). When oxidative phosphorylation stops, the production of ATP within the mitochondria

stops as well (Charles et al., 2016). It has also been found that when fluoxetine crosses the

membrane of the mitochondria it causes a decrease in the activity of the complex IV protein

within the electron transport chain. This will cause a decrease in ATP production (de Oliveira,

2016).

In order to understand the effect that the antidepressant fluoxetine has on mitochondria

and the correlation between depression and mitochondrial dysfunction, the current study was

conducted to test the hypotheses that an increase in fluoxetine concentration will lead to an

increase in mitochondrial clustering and a decrease in mitochondrial membrane charge and

mitochondrial abundance within an axon. Human neurons derived from induced pluripotent stem

cells and chick embryo neurons derived from 10 day chick embryos, were given an acute

exposure of different concentrations of fluoxetine for one hour. Then, they were stained with the

mitochondrial vital dye Rhodamine 123 (R123) to render the mitochondria visible within the

axon to calculate the mitochondrial abundance, distribution, and activity level within an axon.

Materials and Methods

Materials:

The materials for this experiment were obtained from Sigma Aldrich. Rhodamine 123 stock

concentration of 10 𝜇g/mL was diluted and used for fluorescent dyeing. The full list of materials

can be found within the procedure written by Dr. Robert Morris (Morris, 2022). Imaging was

completed using a Nikon Eclipse TS100 inverted microscope with an Idea 3.0 amp color mosaic



camera model 27.2 (which was used to look at human neurons), Nikon Eclipse E400 Microscope

with Insight FireWire 18.2 color mosaic camera, and Nikon 100W mercury lamp (which was

used to look at chick embryo neurons), Nikon Intensilight C-HGFI Fluorescent Generator, and

SPOT software (Version 5.2.5), ImageJ (Version 1.53k), run on MacOS X 10.13.6

Chick Dorsal Root Ganglia

The chick dorsal root ganglia were obtained from 10-day chick embryos (Gallus gallus)

following the Primary Culture of Chick Embryonic Peripheral Neurons 1: DISSECTION

procedure (Morris 2022). Ganglia grew in the incubator for 2 days prior to the fluoxetine

administration.

Induced Pluripotent Stem Cell-Derived Human Neurons:

The human mixed cortical neurons were obtained from EverCell Bio, INC (Natick, MA).

Fluoxetine Solution Preparation and Application for the Chick Dorsal Root Ganglia

Studies have been conducted to see the effect of fluoxetine dosage on

depression-associated behavior in mice ( Iñiguez et al., 2019). The dosages used in the study were

5 and 10mg/kg for acute treatments of the mice (Hodes et al., 2010). Using these dosages, an

equal concentration in 𝜇g/mL can be computed, using the density of water to allow for the

concentration for a volume instead of a mass. An animal's body can be considered water, so a

ratio of 1 kg = 1 L of water can be used to convert between the dosage units.

For chick embryo neuron experimentation, 8 mg of fluoxetine was dissolved in 0.8 mL of

DMSO to create a 10 mg/mL stock solution (Invitrogen Cat. #R302). 2 mL fluoxetine solution of



20 𝜇g/mL and 40𝜇g/mL were created to administer to the chick embryo neurons. To make the

final 2 mL fluoxetine solution of 20 𝜇g/mL in L-15 Neuronal Growth Media (L15 NGM), 4 𝜇L

of stock solution of fluoxetine was added to 2 mL of L15 NGM. To make a final solution of 2

mL fluoxetine at 40 𝜇g/mL, 8 𝜇L of stock solution was added to 2 mL of L15 NGM. A full

buffer exchange was completed to apply the fluoxetine solution after which the chick embryo

neurons were placed in the incubator for 1 hour. After incubation, Rhodamine123 was added to

stain the mitochondria.

Fluoxetine Solution Preparation and Application for the  Human Neurons

For the human neurons, only a 20 𝜇g/mL fluoxetine solution was administered to the cells. To

make the 40 𝜇g/mL working fluoxetine solution, 4 𝜇L of the fluoxetine stock solution was added

to 1 mL of human growth medium. A half buffer exchange was completed by adding 0.4 mL of

the fluoxetine to 0.4 mL of the human growth medium onto the cells to allow the final

concentration within the wells to be 20 𝜇g/mL. The cells were placed in the incubator for 1 hour.

After incubation, Rhodamine 123 was applied to stain the mitochondria.

Rhodamine123 Dilution and Application

Rhodamine 123 is a mitochondrial vital dye that is used to detect membrane potential within

mitochondria (ThermoFisher, 2022). The brightness of the dye corresponds to the membrane

potential within the mitochondrial matrix (ThermoFisher, 2022). An increased membrane

potential lead to a greater ATP production (Dimroth et al, 2000). Therefore the brightness of the

Rhodamine 123 corresponds to ATP production. The ideal dilution of the 10 𝜇g/mL R123 stock

solution was found to be 1:2500. The solutions were kept in a tin foil-covered bottle to prevent



light exposure. For the chick embryo neurons, the solutions were prepared in Hank’s Balanced

Salt Solution (HBSS). 0.8 𝜇L of R123 was added to 2 mL of HBSS to achieve the final

concentration of 1:2500. Once the R123 solution was prepared, 2 mL were pipetted into the cell

dishes using a complete buffer exchange. Dishes were then incubated at 37°C for 10 minutes.

After incubation, the cells were washed with HBSS 3 times for 5 minutes before returning the

labeled cells to L15 NGM and transferring the cover slip containing the neurons into a chip

chamber (Morris, 2022).

Human neurons were grown in 8 well chamber slides. It was determined that a 1:5000

dilution of 10 𝜇g/mL R123 stock solution in human growth medium was the most effective

dilution to properly stain the human neurons. To reach the target concentration of 1:5000, a

1:2500 working solution was prepared by mixing 1.6 𝜇L of R123 stock solution in 4 mL of

human growth medium. 0.4 mL of the prepared, 1:2500 dilution was added to the preexisting 0.4

mL of growth medium in the wells. Cultures of human neurons are mechanically more fragile

than cultures of chick embryo neurons, so fluoxetine was administered to the wells containing

the human neurons using a half buffer exchange. This ensured that the neurons were protected

from strong shear forces while new solutions were introduced to the sample. The cells were then

incubated for 10 minutes at 37℃ before being taken out to wash. Continuing with half exchanges

so as to not disrupt the neurons, washes were completed by removing 400 𝜇L of the R123

dilution from the well and adding 400 𝜇L of human growth medium to reduce background

fluorescence and achieve an optimal signal-to-noise ratio. This process of washing was

completed 18 times.



Fluorescent Imaging of Chick Embryo Neurons

Fluorescent imaging of the chick embryo neurons was performed using the SPOT Insight Model

18.2 camera with the Nikon Eclipse E400 microscope, Mercury-100W M100T fluorescence

lamp, and SPOT software (Version 5.2). After staining and washing with R123, the coverslip

containing the chick embryo neurons was transferred to a microscope slide to form a chip

chamber as described elsewhere (Morris, 2022). The chip chamber was then viewed under the

microscope until defined axons could be seen using the transmitted light view. An image was

taken of the transmitted light view to use as a reference for mitochondrial detection. Following

the transmitted image being taken, the stage was not moved until the fluorescent images were

obtained. Green fluorescent images were captured. Once the cells were exposed to the

fluorescent light, the fine adjustment knob was quickly used to sharpen the focus on the axons

before closing the shutter again. Minimizing the amount of time the neurons were exposed to the

fluorescent light ensured that there would be minimal bleaching. The shutter was then reopened

and an image was immediately taken using between 4 and 8 milliseconds of exposure time.

Following the capture of a fluorescent image, the shutter was closed again until the imaging of

the next area.

Fluorescent Imaging of Human Neurons

Fluorescent imaging of the human neurons were taken using a Nikon Eclipse TS100

inverted microscope, SPOT Idea Model 27.2 camera, Nikon Intensilight C-HGFI  fluorescence

generator, and SPOT software (Version 5.2). Following staining and washing, the neurons were

imaged. The wells were aligned so that the center of the wells were directly over the light to

reduce the risk of refracting the light. The cells were viewed under transmitted light until an axon



was in focus in the viewfield. An image was taken of the transmitted light view to use as a

reference for mitochondrial detection. Following the capture of a representative transmitted light

picture, the stage was not moved while capturing the fluorescent images. The fluorescent images

were taken by shutting off the light source, pushing the pin in for green fluorescence, and then

opening the shutter and viewing the cells with the fluorescent light. Once an axon was in focus

using the fine focus knob, the shutter was closed. The image settings were to view the cells with

an exposure of 2000 and a gain of 4 using SPOT software. The final fluorescent images were

captured using the 2000 exposure with a gain of 2.

Image Analysis and Data Collection

The images that were taken using SPOT software were downloaded into ImageJ (Version

1.53k). The computer that was used for analysis was a Mac OS X. Discrete mitochondria were

defined by comparing the transmitted and fluorescence images as follows: discrete mitochondria

had a bright ovid shape in the fluorescence image and dark ovoid shape on the transmitted image

which corresponded with at least a 1.3-fold increase in brightness within the span of 4 pixels for

the fluorescent image (Kelly, 2020). A cluster of mitochondria was defined by having a 5.4 fold

increase in brightness within the span of 8 pixels, a larger area, and non ovoid shape.

Mitochondria within varicosities, which are enlarged osmotic portions of the axon easily seen

within a transmitted microscope, were excluded from the count (Gu, 2021). Based on these

definitions, the number of mitochondria and clusters were counted for one focused axon in each

of the different fluoxetine concentration samples for both the human and the chick embryo

neurons.



The images that were taken using SPOT software were downloaded into ImageJ. The

brightness for background and cytoplasm was calculated by determining the average gray value

of the plot profile for each region of the cytoplasm next to the mitochondria and background

throughout the image, and the average peak gray value of the plot profile was determined over

each discrete mitochondrion. This mean value was used as the threshold in a later step.

Then the average mitochondrial charge was calculated by subtracting the gray value of the

background and the cytoplasm from the peak value of each discrete mitochondrion (Average

mitochondrial charge = Peak - Background - Cytoplasm).

The transmitted image and the corresponding fluorescent image for each individual

fluoxetine condition were opened together. The images were converted into a stack using

Image>Stacks>Images to Stack tool, allowing the axons and cell bodies of the transmitted and

fluorescent images to overlap. The stack was then converted to grayscale by using the

Image>Type>8-bit option. Then using Analyze>Set Measure then deselected the “Limit to

threshold” box. The threshold that was found in the previous step was set using the

Image>Analyze>Threshold function for the fluorescent image. The bottom slider of the

threshold was set to 255 and the top slider was set to the threshold found previously and the

<Apply> button was clicked. The black pixels of the fluorescent image represented the

mitochondria and the white pixels represent the background (non-mitochondrial portion of the

axon and image).The polygon lasso tool was used to form a box around the axon present in the

transmitted image and mirrored it onto the fluorescent image to outline where the axon would be.

Then, using the Image>Analysis>Histogram tool and clicking the “List” button, the number of

black pixels and the number of white pixels for the axon was listed. The total number of white

pixels (value=0) was recorded as well as the total number of black pixels (value=255). This



procedure was repeated for each different concentration for the human and chick embryo

neurons.

Results

Mitochondrial Density

The hypothesis that the presence of fluoxetine will decrease mitochondrial density within

human and chick embryo axons was analyzed using the vital dye R123 (Figures 1 and 2). With

this image data the percent of axon area containing mitochondria was determined for control and

experimental axons (Figure 3). The data appeared to have a downward trend for both the human

and chick embryo neurons, however after performing a one-sample T-test the difference in the

ratio between treatments was found to have no statistical significance.

Mitochondrial Clusters

The hypothesis that the presence of fluoxetine will increase the ratio of mitochondrial

clusters to discrete mitochondria within axons was analyzed using R123 (Figure 4). The ratio of

discrete to clustered mitochondria appeared to have an upward trend for both the human and

chick embryo neurons, however, after performing a one-sample T-test the differences in the ratio

between the treatment and control was found to have no statistical significance.

Mitochondrial Charge

The hypothesis that the presence of fluoxetine will decrease mitochondrial membrane

charge was analyzed using R123 fluorescence (Figure 5). For the chick embryo neurons, no

significant decrease in mitochondrial brightness was found between the two treatment groups

using a two sample t-test, however, a significant decrease was found between the control chick

embryo neurons and the 20 μg/mL with a p-value of 0.0002 as well as the 40 μg/mL with a



p-value of 0.0018. The median mitochondrial brightness of the 40 μg/mL chick embryo neurons

was less than the 20 μg/mL solution, but further testing needs to be conducted to prove a

significant difference. For the human neurons, a two-sample t-test was performed to see if there

is a statistically significant increase in mitochondrial brightness. The two-sample t-test showed a

statistically significant difference between the two means with the 20 μg/mL mitochondria being

between 16.06 and 32.07 gray scale units greater than the control human neurons with 95%

confidence (p=3.99x10-7). These findings support the experimental hypothesis and contradict the

pattern shown by the chick embryo neurons.

Figures Compared

Figure 3 and Figure 4 demonstrate that the density of mitochondria within an axon

decreases as fluoxetine concentration increases, but clustering decreases. It should be noted that

for both the control treatments in both figures the human neurons have half the value of the chick

embryo neurons. This similar pattern is demonstrated in Figure 5 for the control, showing that

the average mitochondrial brightness in the chick embryo neuron is once again higher in value

than the control for the human neuron, as shown in the previous two figures. However, this

pattern is only not shown



Figure 1: Chick embryo neurons displayed side by side using transmitted (A, C, E) and
fluorescence micrographs (B, D, F). The illuminated points along the axon in the fluorescence
images are mitochondria rendered fluorescent with the vital dye Rhodamine 123. Images (A) and
(B) show the chick embryo neurons from the control treatments. Images (C) and (D) show the
images for the 20 𝜇g/mL fluoxetine treatments. Images (E) and (F) show the 40 𝜇g/mL fluoxetine
treatments. Notice the difference in the clustering of mitochondria between the chick embryo
neuron control, 20 𝜇g/mL, 40 𝜇g/mL. The number of mitochondria clusters visibly increases as
the concentration of fluoxetine increases.



Figure 2: Human neurons displayed side by side using transmitted and fluorescence micrographs.
The axon that is outlined is the axon that was used in density, cluster, and charge analysis. The
illuminated points along the axon in the fluorescence images are mitochondria rendered
fluorescent with the vital dye Rhodamine 123. Images (A) and (B) show the human neurons that
have received the control treatment. Images (C) and (D) show the human neurons treated with
the 20 𝜇g/mL fluoxetine dosage. Notice the difference in the clustering of mitochondria between
the human neuron control and the human neuron 20mg/mL. The number of mitochondria clusters
visibly increases as the concentration of fluoxetine increases.



Figure 3: Mitochondrial density measured by the ratio of the mitochondrial area to total axon
area for the chick embryo neurons and human neurons. Little change was detected between the
chick embryo neuron control and the 20 𝜇g/mL treatment, however a dramatic decrease in
mitochondrial density was noticed when the 40𝜇g/mL fluoxetine treatment was applied. Little
change was noticed between the control human neuron and the 20 𝜇g/mL treatment, however the
mitochondrial denity of the human neurons was consistently half that of the chick neuron.  For
the chick embryo neuron control condition, data are derived from 34 discrete mitochondria and 2
mitochondrial clusters observed in a total of 227.6 micrometers of axon in one image from one
trial. For the chick embryo neuron 20 𝜇g/mL fluoxetine concentration condition, data are derived
from 15 discrete mitochondria and 4 mitochondrial clusters observed in 176.5 total micrometers
of axon in one image from one trial. For the chick embryo neuron 40 𝜇g/mL fluoxetine
concentration condition, data are derived from 36 discrete mitochondria and 1 mitochondrial
cluster observed in 221.4 total micrometers of axon in one image from one trial. For the human
control neurons condition, data are derived from 9 mitochondria and 1 discrete mitochondrial
cluster observed in 131.5 total micrometers of axon in one image from one trial. For the human
neurons 20 𝜇g/mL fluoxetine concentration condition, data are derived from 10 discrete
mitochondria and 3 mitochondrial clusters observed in 244 total micrometers of axon in one
image from one trial. No data were collected for the 40 𝜇g/mL fluoxetine human neuron.



Figure 4: The ratio of clusters to discrete mitochondria in axons for 0 𝜇g/mL and 20 𝜇g/mL
fluoxetine solution in the chick embryo and human neurons. There was almost a 5 fold increase
in the ratio of mitochondrial clusters to discrete mitochondria from the control to the 20 𝜇g/mL
of human neurons. There was almost a 3 fold increase in the ratio of mitochondrial clusters to
discrete mitochondria from the control to the 20 𝜇g/mL of chick embryo neurons. The clustering
ratio for the control human neurons was half that of the control chick embryo neurons. For the
human control condition, data are derived from 9 mitochondria and 1 discrete mitochondrial
clusters observed in 131.5 total micrometers of axon in one image from one trial. For the human
neurons, 20 𝜇g/mL fluoxetine concentration condition, data are derived from 10 discrete
mitochondria and 3 mitochondrial clusters observed in 244 total micrometers of axon in one
image from one trial. For the chick embryo neuron control condition, data are derived from 34
discrete mitochondria and 2 mitochondrial clusters observed in a total of 227.6 micrometers of
axon in one image from one trial. For the chick embryo neuron 20 𝜇g/mL fluoxetine
concentration condition, data are derived from 15 discrete mitochondria and 4 mitochondrial
clusters observed in 176.5 total micrometers of axon in one image from one trial.



Figure 5:  The average brightness of discrete mitochondria in axons for 0 𝜇g/mL, 20 𝜇g/mL, and
40 𝜇g/mL fluoxetine solution of chick embryo neurons and 0 𝜇g/mL and 20 𝜇g/mL fluoxetine
solution of human neurons. There was a 2 fold decrease in mitochondrial brightness between the
chick embryo control neurons and the chick 20 𝜇g/mL treatment. There was a 1.7 fold decrease
in mitochondrial brightness between the chick embryo control neurons and the chick 40 𝜇g/mL
treatment. There was a 3 fold increase in mitochondrial  brightness between the human control
neurons and the human 20 𝜇g/mL  For the chick embryo neuron control condition, data are
derived from 34 discrete mitochondria and 2 mitochondrial clusters observed in a total of 227.6
micrometers of axon in one image from one trial. For the chick embryo neuron 20 𝜇g/mL
fluoxetine concentration condition, data are derived from 15 discrete mitochondria and 4
mitochondrial clusters observed in 176.5 total micrometers of axon in one image from one trial.
For the chick embryo neuron 40 𝜇g/mL fluoxetine concentration condition, data are derived from
36 discrete mitochondria and 1 mitochondrial cluster observed in 221.4 total micrometers of
axon in one image from one trial. For the human control neurons condition, data are derived
from 9 mitochondria and 1 discrete mitochondrial cluster observed in 131.5 total micrometers of
axon in one image from one trial. For the human neurons 20 𝜇g/mL fluoxetine concentration
condition, data are derived from 10 discrete mitochondria and 3 mitochondrial clusters observed
in 244 total micrometers of axon in one image from one trial. No data were collected for the 40
𝜇g/mL fluoxetine human neuron.



Discussion and Conclusions

This study was conducted to test the hypothesis that an increase in fluoxetine

concentration leads to an increase in mitochondrial clustering, as well as a decrease in

mitochondrial membrane charge and mitochondrial abundance within an axon. The hypothesis

that mitochondrial clustering would increase in the presence of fluoxetine was supported by the

data for both chick embryo neurons and human neurons (Figure 3). Both types of neurons also

supported the hypothesis that mitochondrial abundance would decrease in the increased presence

of fluoxetine (Figure 4). However, only the chick embryo neurons supported the hypothesis that

fluoxetine would cause a decrease in mitochondrial membrane charge (Figure 5), with the human

neurons showing contradicting results.

Recent studies have shown that mitochondrial dysfunctions can lead to depression. ( Allen

et al., 2018). SSRIs target neurotransmitter reabsorption within the synapse; however,

pharmaceutical drugs that target mitochondrial function within neurons, as well as

neurotransmitter reabsorption, may lead to new options for treatment. The correlation between

mitochondrial dysfunction and depression reinforces the importance of testing if current SSRIs

have unintended negative effects on mitochondrial functions, especially in neurons.

The results in this study may have implications for the study of the effectiveness of

fluoxetine in treating depression. Results from the ratio of mitochondrial area to total axon area

(Figure 3) were evaluated using a one-sample t-test to determine if there is a significant

difference between the ratios for each fluoxetine concentration. While the data are not

statistically significant; the data suggests an interesting trend that may show statistical

significance given a larger data set. Our preliminary data (Figure 3) suggests that as the



concentration of fluoxetine increases, the density of mitochondria within an axon may decrease,

and consequently so would ATP production. If this were the case it would suggest that fluoxetine

may contribute to mitochondrial dysfunction.

The data showing the ratio between mitochondrial clusters to discrete mitochondria in an

axon for both the human neurons and chick embryo neurons (Figure 4) may be used to determine

if fluoxetine causes a shift in mitochondrial distribution within the axon. Results from Figure 4

were also evaluated using a one-sample t-test to determine if there is a significant difference

between the ratios for each fluoxetine concentration. A larger data set could better test for

statistical significance of the trend that as fluoxetine increases in concentration, the ratio of

clusters to discrete mitochondria will increase.

This study may have implications for the effects that fluoxetine has on mitochondria and

the amount of ATP that can be generated within an axon.  Research shows individuals with

mitochondrial dysfunctions produce less ATP within the neurons of the hippocampus, cortex, and

hypothalamus ( Allen et al., 2018). Due to the downward trend that is occurring for the ratio of

mitochondrial area to total axon area as the fluoxetine concentration increases (Figure 3), it

would suggest that increased levels of fluoxetine decrease ATP production within a given axon.

However, this study may show that membrane charge increases (Figure 5) within human neurons

in the presence of fluoxetine signifying that there could be an increase in ATP production within

the mitochondria (Dimroth et al, 2000). The presence of fluoxetine may lessen the density of

mitochondria within an axon but simultaneously may increase membrane charge in each

individual mitochondria.



This study could be used to look into the effects that fluoxetine has on the mitochondria’s

ability to produce ATP. Analysis of the chick embryo neurons shows a downward trend in

mitochondrial brightness between the control and fluoxetine treated cells. This indicates a

decrease in membrane potential and therefore a decrease in ATP production. However, after

performing a 2-sample t-test, the human neurons present a statistically significant increase in

brightness between the control and the treatment group. These results may appear because the

chick embryo neurons are peripheral sensory neurons from dorsal root ganglion and therefore

may not have similar fluoxetine receptors and therefore share the same sensitivity to fluoxetine

as the cortical human neurons. The cortical human neurons are found within the brain cortex and

therefore may be more likely to have the same responsiveness as native human brain neurons to

fluoxetine.

Several experiments could be performed to further extend the understanding of the data

within this experiment. A greater number of trials will help better test the significance of the

trends within this experiment. Chronic exposure of fluoxetine could be administered to see if

chronic treatment shows a similar trend for mitochondrial abundance, membrane charge,  and

distribution within an axon. This is important to know because many studies use chronic

treatment to see the impact that fluoxetine has on depression ( Iñiguez et al., 2019). Another

finding that came from the study is the clustering of fluorescent mitochondria in certain areas of

the axon. This clustering can be the result of specific areas of the axon needing more ATP

production. This is important to know because clustering may impact ATP distribution within an

axon

This data regarding fluoxetine and mitochondrial abundance as well as distribution shows

potential for further studies on the effectiveness of SSRIs. Depression is a disease that affects



approximately 280 million people globally (Depression, 2021), and a pharmaceutical regimen

that addresses both the neurotransmitter and mitochondrial causes of depression can increase the

efficacy of treatment.
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